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1 Welcome to Presenter 4

Thank you for evaluating Presenter 4!

Presenter is a multimedia control system for displaying text, video and other media
formats. We hope it will serve as a valuable tool for your presentation needs.

Learning the features and getting the most out of new software can take some time and
some help along the way is often appreciated. For this reason, we invite you to contact us
for support during the evaluation period if you have any question. Making sure your
preferred video files play back correctly, for example, may require installing a codec pack

. While we cannot guarantee all video formats will work, we will certainly try to help
along the way if we can.  We would suggest though to first make full use of the help
information here and check our web site in case your query has been already addressed.

First Time Setup

The very first time Presenter starts up it will
automatically assign the outputs to the available
displays. If Presenter only found one display, a custom
monitor  is created and assigned to Output 1 (front of
house) to enable you to set started. This output is
located in the top right hand corner (50% width and
height) and will therefore overlap the control window.

Getting Started - New Users

Please read the Introduction  and Quick Start Tutorials  sections to familiarize
yourself with the basics of the program and to configure your monitors.

Getting Started - Users upgrading from previous versions of Presenter

For a quick summary of the major changes to Presenter from Version 3, see the 
Upgrade FAQ .

For a summary of the changes in Version 4, see What's new in Version 4.1 ,
What's new in Version 4.2  and What's new in Version 4.3

Even if you are an experienced Presenter V3 user, we recommend that you run
through the Introduction  and Quick Start Tutorials  sections.  While some
operational aspects will be familiar the move to support multiple media types adds a
new dimension to the operation.
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2 Introduction

The topics in this section provide some basic information about Presenter 4 and what you
can achieve.

2.1 About Presenter

Presenter is a media presentation application used to display various information on one
or more output displays for a live event.

Feature Overview

Prior to Version 4, Presenter's main aim was for displaying song text in a manner
that was easy to control. Plain text files formatted with blank lines to delimit each
slide was all that was required as input. Presenter's display options ensured a
consistent appearance and the thumbnail slide view enabled the operator to follow
the leader as required and not be dependent on a set sequence.

Version 4 opens the door to a whole new level of possibilities. While there are the
obvious features geared for church services, Presenter 4 can be equally at home in
the school classroom or corporate presentation event. Just some of the features
include:

Advanced monitor detection and output configuration

Four (4) monitor support

Integrated Microsoft® PowerPoint support

Video clips with text overlay

Video capture with text overlay

Audio file playback

DVD playback

Bible support

Adobe® (Macromedia) Flash Support

New text style configuration, including semi-transparent regions (as seen under
broadcast TV captions)
Spell checker

Text Override facility

Browser style file selection

New facility for complete control of images

Background image support at the song AND individual page level

Output splitting of text and images. Eg. Display slides in two languages on
separate monitors in a single action
Slide transition effects (fade, wipe, roll, etc.)

Foldback clock, countdown timer and media progress timer

Loading and saving Running sheets with user timestamp and description
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Transparency and alpha-blending of text over media playback and external
applications

2.2 What's new in Version 4.1

Version 4.1 includes several enhancements and new features.

Browser

New: Checkbox selection of libraries (similar to V3)

Updated: Default location for searching is now the Presenter home location.

Media

New: FLV (Flash Video) support*

New: Apple QuickTime support*

New: Media streaming (mms://) protocol for WinXP systems (experimental)

Updated: Song lyrics cater for revised CCLI SongSelect format

Updated: Improved output start up transition of video and flash media

Fixed: '.' tag line break not working in song lyrics

* Tested with latest K-Lite codec drivers

Output Control

New: Video - Auto and manual fade in/out

New: Video - Auto-close window on end

New: Header/footer options for song title and copyright information

New: Choice of three program control views

New: Ability to individually assign overlay and background slides to each output

New: Message facility overlays existing song text

New: Transparent feature for showing slides over Windows desktop or other media

Updated: Enhanced fade in/out control for Overlay & Background slides

Updated: Improved keyboard shortcut control. Added arrow keys for lyric slide changes.

Updated: Overlay shortcuts F8/F6 to Show/Hide lyrics

Updated: Period '.' shortcut toggles blank/current slide selection

Updated: Improved transition smoothness of text and images

Fix: PPT started external viewer even if [PPT] option unset

General

New: Load progress indication on startup splash screen

New: Initial program view is determined by the number of monitors.

New: Added several quick links for help and option settings

New: Output preview panel indicates if no outputs are defined.

New: Option to export song lyrics and running sheet list to CSV file
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Updated: Increased maximum value of the margin values in the output settings

Updated: Improved detection for Adobe Flash not being installed (previous, a "Class not
registered" error appeared)

Keyboard shortcut changes

There are a couple of changes in keyboard operation
from Version 4.0. See Keyboard Shortcuts  for
details.

2.3 What's new in Version 4.2

Version 4.2 includes several enhancements and new features.

Song Lyrics
Drag 'n drop background images into song preview on the fly

Live Sequence Update in output

New Operator Comments tag

Image Folders
Support for Powerpoint remote devices  (ie. use remote to present image slide show)

Powerpoint
Assign output for image in the preview panel

Timing and auto play settings (See Tutorial )

Detect and turn off "Blank slide at end" option

Improved support for Powerpoint remote device (See Options > Control Window >
General)  topic
New: Slide count prompt on foldback display

DVD See Playing a DVD  tutorial.
Added title, menu and restore control buttons

Added menu navigation buttons

Chapter start and auto play settings

Enhanced direct mouse support

One step "Quick play" option to load and start a DVD

Improved error handling

Browser
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Revised toolbar for easier navigation, song lyric editing and selection

New: Launch Windows explorer  option

Added modified timestamp to file detail view (also in CSV export)

Running Sheet
Select individual outputs for each item

Added context menu for Item Actions : Edit, Remove & "Open containing folder"

Display of extra timing (start/stop) information

Foldback countdown
New format options  to show seconds and add parentheses

Time now resets to 10 mins

Miscellaneous Improvements
Add CCLI song no. to item list export

Control window positions now saved between sessions

Cache is now cleared on startup

File extensions MKV, MKA and M4A now recognised

Fixed non-detection of Unicode files in lyric editor

Keyboard shortcut changes

There are a couple of changes in keyboard operation
from Version 4.1. See Keyboard Shortcuts  for
details.

2.4 What's new in Version 4.3

Version 4.3 includes several enhancements and new features.

Browser
View settings for lyrics, images and media are saved and restored separately

Running Sheet
Fixed item output assignments not being restored correctly on load

103
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Images
Added best fit/stretch option

Video
Improved video load logic on double-click action with preview closed

Eject button is now enabled while playback is active

Fade level defaults to 0 on initial load (for autoplay fade start)

Auto fade out and in on change of video clips

Video fades out at end if autoplay on

New option for default video fade speed

New option to hide video countdown  on foldback for loops

Miscellaneous Improvements
New: Foldback count-up  feature

Internal memory optimisation to reduce RAM requirements

Make allowance for control window being maximized on startup

New transparency link  option to toggle the background and transparency options

2.5 FAQ for Upgraders from Version 3

The user interface of Presenter 4 is very different to previous versions, although existing
users will find some familiarity with the layout and general operation.

Key differences between Version 3 and Version 4

Function Version 3 Version 4
Monitor support 1 to 3 monitors 2 to 4 outputs, where 1 output =

1 or more monitors (eg. array of
3 X 3 monitors)

Item types Lyric files in plain text
format

Lyric files in (compatible) text
format, Images, PowerPoint,
Audio, Video, Flash, DVD, Live
capture feed, Live video/audio
streaming

Item library Songs stored in a single
tiered "library" (folder)
structure.

File browser across all computer
resources providing near
identical functionality to Windows
Explorer, including right-click
context menu.

Item search Quick search for file names
and lyric text

Two options:
1. Quick search for file names

and lyric text, and
2. General file search facility

39
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(similar to Windows Explorer)
Item queue Referred to as the Play List.

Play lists can be named
and saved for later retrieval.

Referred to as the Running
Sheet.
Running sheets can be named
and saved for later retrieval. They
can also be given a description,
a user defined session reference
and date/time stamp.
As well as loading items from
Presenter's browser, items can
be dragged and dropped from an
external source (eg. the desktop
or separate Windows Explorer
window)

Preview panel - New: A selected item in the
running sheet can be previewed
before sending to the output.
Some media items can have
certain properties set, such as
queued with mark in/out points.

Image support Set by a global display
scheme setting for each of
the FoH and FB outputs.
Image changed on demand
from the control window.

Loaded as individual images or
folder collection into the running
sheet. Output control includes
separate thumbnail which can be
faded in under text as required.

Slide transition Basic fade in/out of slide to
background image or black.

19 slide transitions activated on
change of overlay slide or image
background.

Overlay thumbnail Includes tag reference for
keyboard shortcuts.

As per Version 3, but inserts an
initial blank slide.

Setting up Version 4 to operate like Version 3

For Version 3 users, the visual difference of Version 4 may appear daunting at first.
It is in fact almost identical to operate for song lyrics by checking the following
settings:

Browser Check List View: The folder view of navigating file contents will be
second nature for anyone familiar with the regular Windows file explorer.
However, Presenter's browser has a "Check List View", which can present song
lyric folders with a checkbox to make it easier to filter (or limit) the song list to one
or more folders. This is identical to the library feature in Version 3, with the
exception that you can have nested folders in V4. Simply clicking a checkbox next
to a folder (library) will refresh the song list accordingly. There is a main Filter list
checkbox which is equivalent to the All/Selected option in V3. For details, see
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Browser > Folder Check List .

Hide Preview Panel: The preview panel makes it easier to prepare individual
media settings without sending them to the output first. For example, setting start
and end points in a video. When the preview panel is open, a single click in the
running sheet (aka play list) will load the item only to the preview.  If you are
working primarily with song lyrics, closing the preview panel (click on top edge or
press F4) will mean your song item will be loaded directly to the output - the
same as in Version 3. See Preview Panel  for details.

Basic Program View: The output section on the right hand side offers several
buttons and sliders to allow full control of your presentation. Since V4 now
includes support for multiple outputs as well as a wide range of media and slide
transitions, several of these controls may not be of concern to you - at least in the
short term as you become familiar with the program. Once again, if you are
mainly working with song lyrics, select the Program View: Basic view (just below
the output preview windows) to reduce the 'clutter' of the control area if it is not
already shown. You will notice that the function shortcuts F6 and F8 are marked
on the side of the slider. These equate to stop (off) and play (on) in Version 3.
Just make sure the overlay and program [Slide] button are on as well (with a
green arrow). For more details, see Basic View .

2.6 Multi-Monitors

You have probably heard of the term multi-monitor or dual-monitor. This refers to a feature
provided by Microsoft operating systems since Windows 98 (quite apart from MacOS and
Linux). It is not a function of Presenter, but rather a feature that Presenter uses, in the
same way that PowerPoint (since MS Office 2000) has the ability to nominate an output
that the slideshow will be displayed on.

What is Multi-monitor?

Multi-monitor support in Windows is the ability of the operating system to detect
more than one video adaptor and enable the desktop to be extended across
monitor outputs. This support is normally achieved by adding one or more
additional video cards, but single video cards providing two (or more) outputs
are common nowadays. The later are referred to as 'dual head' cards. (See
below)

Notebooks do not miss out on this technology. The chipsets in current
notebooks support a dual-monitor configuration, enabling the external port to be
treated as the second output.

If you imagine sitting in front of a computer monitor, with the screen resolution
set to 800 X 600. Now place (imagine) another monitor on the right hand side. If
both of these were connected and configured correctly, you would be able to

108

116

147
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drag any window (that is not full screen) off the right hand side of the first
monitor, and it would appear on the left hand side of the second monitor. The
proverbial brick wall you are used to when the mouse cursor reaches the sides
of the screen has been knocked down on the right hand side. You are effectively
working with a 1600 X 600 desktop 'real-estate'. Actually, varying screen sizes
(and color settings) can normally be configured, so one screen might be 1024 X
768 and the other 640 X 480. Three or more video outputs is simply an
extension of this idea, with additional monitors placed logically next to, or above
or below the 'primary' monitor.

Configuring multi-monitor support in Windows XP is almost exclusively
performed in:
a) the Settings page of the Display Properties (either select this from the Control
Panel or simply right-click anywhere on the desktop and select Properties), and/
or
b) in the Advanced section of the Settings page. Video card drivers often extend
the options available on the advanced tab.

On Windows Vista and Windows 7, monitor detection is built in so that the
additional output may actually be enabled as soon as you attach the additional
hardware.

Dual or Multi-Monitor?

The terms dual-monitor and multi-monitor are often interchanged as they generally
refer to the same thing. Technically though, multi-monitor is a better term, since
Windows can support more than two video adaptors.

Configuring Multiple Monitors

Installing a second video card should be as simple as adding a new piece of hardware.
Volunteer someone to help you if you are not comfortable with taking the cover off your
computer.

In a nutshell...

1. Install video card
2. Boot Windows -> Follow the prompts to load drivers as required
3. Allow to reboot if required
4. Right-click the desktop and select Properties > Settings tab.
5. Select the 2nd monitor and tick Extend my Windows desktop onto this monitor.
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Sam ple dis play properties  in  W indows  XP

Laptop Users

You may find that after enabling the second monitor
and applying the changes, that the setting does not
'stick'. (That is, the second monitor remains disabled.)
This will occur if the external (VGA) port is not
connected, or the device (eg projector) is not switched
on. If you are trying this out for the first time, connect a
normal PC monitor. It will be much easier to explore
this feature until you become more comfortable with
what is going on. We recommend connecting and
turning on the external device (monitor or projector)
before starting the notebook.
Again, on Vista and Windows 7 systems this may not
be necessary.
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What is a dual head card?

A dual head video card contains two (D-Sub 15, DVI and/or TV) video outputs on the
one card. 

An early m odel Matrox video adaptor

nVidia Quadro FX 5600  SDI

Large Desktop effect

You might have come across the term: large desktop. This was coined back in the
days of Windows 2000 when the early WinNT based video drivers for dual head
cards limited the capabilities to a single monitor area. That is, what would ideally be
two independent monitor setups (with their own resolution and color settings) would
be forced to be one "wide" screen (with the same color depth). For example, instead
of two screens with 800w X 600h, the system would report a single 1600w X 600h
display.

The problem with this limitation is that applications had a tendency to position
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windows in the center of the desktop, smack bang across both monitors - splash
screens included. To get around this problem, display card vendors would bundle
additional software to attempt to force windows wholly onto either monitor.  For the
most part these worked OK, but sometimes their attempt at intelligence got the
better of them.

Fortunately this problem was gradually resolved and most vendors had it solved for
WindowXP.  If you do encounter this problem it can be addressed using Presenter's 
custom monitor  feature.

Four outputs on a laptop?

If you're wondering if the additional number of outputs in Presenter 4 is of any value
to a laptop based system, then you'll be pleased to learn that there are solutions
available.

USB Video Adaptors: These devices plug into a spare USB port and with their VGA
socket, enable a monitor/projector to be plugged in. It should be noted however that
the speed of the graphics may prohibit smooth video playback, limiting their use to
image/text presentation.  This may nevertheless be adequate for use as foldback.
A Google search for usb video card will yield many options. Look for USB 2 and
USB 3 models for better performance.

Display adaptor splitters: Matrox have devices called DualHead2Go and
TripleHead2Go which inform Windows that the device can support two or three
times the display width.  This has the characteristics of the large desktop effect
discussed above but since it need not be the primary monitor, those problems are
not generally a concern.  Some of Presenter 4's testing has been done on a laptop
with a TripleHead2Go unit.  All three outputs can be configured using Presenter's 
custom monitor  feature.

67

67
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Matrox TripleHead2Go

2.7 Keyboard Shortcuts

Several keyboard shortcuts are provided as an alternative to using the mouse. You may
wish to print this topic for ready reference.

Shortcut Reference

These are the default keyboard assignments.  Item navigation shortcuts may be
overridden if the presentation controller setting is active (see Options - Control
Window - General ).

Key Action

Page Down
or ]

Next Item

Page Up or [ Previous Item

+, =, N, n
Next Overlay Slide [Arrows new
in V4.1]

-, _, P, p Previous Overlay Slide [Arrows
new in V4.1]

Space Bar† Send item in Preview panel to the
Output

0 through 9 Jump to Overlay Slide number or
tag

/, * Jump to extended Overlay Slide

72



17Introduction

©2011 Discovery Systems

Key Action

tag

. (period), B, b a) Overlay Slide Active => Toggle
between current slide and the first
(blank)  [Updated in V4.1]
b) PPT or image media is loaded
and Presentation remote enabled
in Options => Toggle black slide 
[New in V4.2]

Ctrl+N New running sheet

Ctrl+O Open running sheet

Ctrl+S Save running sheet

Ctrl+Enter Add selected browser item to the
running sheet

Ctrl+Del Delete item from the running sheet

Ctrl+Z Undelete item from the running
sheet

Ctrl+Up
Arrow

Move item up running sheet

Ctrl+Down
Arrow

Move item down running sheet

Ctrl+E Browser - Lyrics checklist view

Ctrl+F Browser - Search (toggle on/off)

Ctrl+G Browser - Folder view (toggle on/
off)

Ctrl-H Browser - Go to Presenter home
folder

Ctrl+M Program Master On/Off

Ctrl-T Browser - Go to Desktop folder

Ctrl+1 Program Slide Output 1 On/Off

Ctrl+2 Program Slide Output 2 On/Off

Ctrl+0 Program Slide Foldback On/Off

Shift+Ctrl+1 Program Media Output 1 On/Off

Shift+Ctrl+2 Program Media Output 2 On/Off

Shift+Ctrl+0 Program Media Foldback On/Off

F1 Help

F2 Browser rename selected file

F3 Jump to Lyrics Quick Search box

F4 Preview panel (open/close)

F5 a) Image thumbnails lists have
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Key Action

focus => Refresh
b) PPT media is loaded and
Presentation remote enabled in
Options => Start PPT
presentation [New in V4.2]

F6 Program Overlay Active Off[New
in V4.1]

F7 Next Overlay tab (cycle Overlay/
Message/Scripture tabs)

F8 Program Overlay Active On and
enable keyboard shortcuts for
overlay navigation. [Updated in
V4.1]

F9 Next Preview tab (cycle O1/O2/FB
output preview tabs)

F10 Add item to the running sheet[New
in V4.2]

F11 n/a

F12 Save running sheet as...

Shift+F8 Program Overlay Background
Active On/Off

Ctrl+F8 Program Background Active On/
Off

ESC Bring Control Window into focus (if
hidden by output window)
Stop PPT presentation (when PPT
media is running and Presentation
remote enabled in Options) [New
in V4.2]

† The Space Bar provides a convenient means to launch the next time, provided the
Preview panel is open and keyboard is fully enabled (refer to Focus topic insert
above). It is the equivalent of pressing the Output button.

In addition, if the Auto-advance mode is active, the next item in the running sheet is
selected, and therefore loaded into the Preview panel.  Refer to Preview Panel  for
details.

116
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Keyboard actions depend on what has focus

In computer software terminology, the term focus refers to the visual
control or field that will receive the keyboard input. You can usually
notice a broken rectangle, or marque, around controls if you use the 
Tab key to step from one to the next, or use the mouse to click over
that location.

Much effort has gone into making Presenter "keyboard friendly" but
there are some limitations that constrained a few actions during
development. For example, the left/right or up/down arrow keys to
move forward and back through slides (as is done in PowerPoint) can
be relied upon when either the F8 key is pressed or an overlay slide is
clicked. However, if focus is moved to the fade sliders for example,
standard Windows behaviour is expected for slider controls when the
arrow keys are pressed. The same goes for text entry and list fields.

For this reason, we have provided a visual clue to assist in determining
whether keyboard actions are enabled. This is entirely dependent on
what control has focus. The symbol in the bottom left hand corner
indicates when Presenter will or will not take action on a keyboard
request.

Keyboard shortcu ts  are
enabled

Keyboard shortcu ts  are
enabled except the space

bar

Keyboard shortcu ts  are
dis abled

Powerpoin t rem ote
keys  are accepted

(New  in  V4 .2)
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2.8 License Considerations

In case you were one of the 98% of the population that clicked past the license agreement
during installation, here is a review of perhaps the most relevant part (in layman's terms)
which is important to be aware of.

Presenter 4 registrations are site based, which means you can install and register it on:

1. Multiple computers located at your Site.  That means, if you have two auditoriums with
separate projector systems you can install Presenter 4 on each computer used to
control those systems.

2. It also means you can install Presenter 4 on other computers at your Site that might be
in, say, an office area.  This would typically be useful for typing up song lyrics or
experimenting with media playback.

3. In addition, you may install and register Presenter 4 on a home computer - away from
your Site, provided the purpose of this remains exclusively for your Site.  Again,
preparing song words or self-training would be the most likely reason for this.  Please
exercise due care when disclosing your registration details to others.

4. Do you hold special events in your community, such as an Easter service in a hired
venue? For one-off occasions like this, it is fine to take Presenter 4 off sight.

OK, now what do we mean by Site?

In all cases described above, Site means one physical location or address.  It does not
encompass multiple campuses at other locations, such as outreach or extension
churches in another suburb or town, even though they may come under the covering of
the same organization or be legally identified as the same incorporated entity. An
additional license must be purchased for each of these cases.

If you have any questions about licensing or registrations, do not hesitate to contact us.

2.9 Program Support

Presenter 4 has had extensive user feedback over a lengthy beta release period. 
Nevertheless, there are sure to be the occasional error pop up at some stage.

Potential Problems

We have found the most vulnerable areas have to do with:

PowerPoint interface. There may be the rare occasion that the link (OLE in
Windows terms) to the PowerPoint.exe program becomes faulty and response to
PowerPoint instructions appears to stop.  If this occurs, reloading a PPT file may
help, but usually i) closing Presenter, ii) checking the task manager that the
POWERPNT.EXE application has terminated, and iii) restarting Presenter will be
the more reliable fix. This should be extremely rare, so if it happens with any
regularity, please contact us.
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Video/DVD playback. Media Formats  provides some assistance to identifying
codec and related problems with video/DVD playback.  It is difficult to provide
(remote) technical support in this regard but we will try to help if possible.

It will be apparent that in these two cases, Presenter is relying on features external to
its' control. In most other cases though, we should be able to provide a greater level
of technical support.  For example, issues with text output or image support.

Handling Errors

In the event of an error occurring, a special dialog box will appear and you will be
given the opportunity to: a) email a report to us, b) display the error, c) continue or d)
end the program.

In most cases you should be able to [continue application], but if that results in
more unexpected behaviour, then close and restart Presenter.

The [send bug report] option will package up the error to send to:
  bug-report@presentersoftware.com 
and place it in the outbox of your email program.

Sending a bug report can help us solve internal errors.
However, you are under no obligation to send them.
Indeed, this may not be feasible if you don't have email on
your Presenter system.

Online Support

Please visit our web site at any time for support information, frequently asked
questions and news items that may be of assistance.

www.presentersoftware.com

2.10 How to buy Presenter

You can buy Presenter either:
online worldwide using VISA, MasterCard, American Express, bank transfer or (within
Australia) by cheque. Your registration details are sent by email which you can use to

64
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unlock the version you are currently using.
through one of our many resellers.  If you found out about Presenter through a reseller,
please contact them directly.

Web contact:  www.presentersoftware.com

3 Quick Start Tutorials

The following topics provide step by step instructions on common tasks.  They also
detour to point out some extra features along the way.

Displaying a lyric file
Displaying a lyric file with background images
Adding background images on the fly
Displaying a single image
Displaying PowerPoint
Displaying text overlayed on video
Displaying a Flash file
Capture live feed
Playing a DVD

3.1 Displaying a lyric file

In this example, we will:

Load a lyric (song) into the running sheet

Send it to the Output

1. In the browser, click Home  and navigate to a folder under Overlay \ Lyrics

Tip: Use the view option to change how the information is displayed.

Detail view: Displays  s ong nam e, title, firs t line, chorus  and
location
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Thum bnail view: Displays  s ong nam e, title, artis t and firs t page

2. Add required item to the running sheet by either:
Double-click item

Select item and press ENTER or F10

Select item and click the Add  toolbar button

Drag item up into running sheet

3. Repeat for additional songs

4. In the running sheet, select the first song
If the Preview is closed, the song will load immediately to the
output.
If Preview is open, the song will load (only) to the preview.

Select an alternative thumbnail if you want the lyrics to start
there (eg. chorus)
Enable or disable the outputs as required

Click the Output  button (or press the space bar)
to load to output

The Space bar only acts as a shortcut if enabled. See
Keyboard Shortcuts .

5. Activate the program output as required.

In Program View: Basic, this will include the Overlay and Slide buttons. For
example:

16
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In Program View: Standard, this will include the Overlay, FoH Slide and Master
buttons. For example:
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6. Use the mouse or keyboard shortcuts  to change pages. Typically: +, -, 0-9 keys

7. Alter the slide transition to suit.  eg. a fast fade

Output Problem?

I don't see the output preview. All I see is this:

16
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Explanation: This simply means that there is no link between the assignable
outputs in Presenter and the actual Windows monitors.

Solution: Click the blue link as indicated (or select Options > Monitor from the
main top menu to: a) review what system monitors Presenter sees, and b) link one
to Output 1 in the Output Definitions section.  Refer to Options > Monitor  for
details.

3.2 Displaying a lyric file with background images

In this example, we will:

Load a lyric (song) into the running sheet that has background images defined
internally
Send it to the Output

Make adjustments while the image is displayed

Take a quick look at how the synchronizing output feature works

1. In the browser, click Home  and navigate to the Overlay \ Lyrics \ Samples
folder

2. Load Test1.txt into the running sheet then send to the Output

3. Observe bottom panel below overlay words showing image controls

66
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4. Enable if red indicator showing  >> 

5. With padlock image open, manually slide image visibility to see effect.

6. Do the same with the overlay controls (to control the text)

7. Click padlock to synchronise controls

8. Change visibility from either control area  <<>> 
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Independent con trol is  ach ieved if the padlock s ym bol is  open .
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Outpu t con trol is  s ynchron ized between  the lyrics  and background when  the padlock is  clos ed.

Extended example: Synchronizing lyrics and background image across multiple
monitors

9. Back in the browser, right-click Test1.txt and select Open to view the contents in
Notepad. You will notice the (new) .b and .- tag lines.

If you have both Outputs 1 & 2 enabled, you'll notice the differing text on each page.
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Sam ple ou tpu t: FoH (Top-righ t); 2nd ou tpu t (Bottom -left); Foldback (Bottom -righ t)

A practical example of this technique is in multi-language situations where you want the
text to be split across the outputs.

Open Blessed be the Lord God Almighty - CE.txt (also in the Lyrics \ Samples folder)
for an example of this.
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Sam ple ou tpu t show ing m u ltiple languages  on  s eparate s creens

3.3 Adding background images on the fly

In the previous example , we utilized the .b tag feature to define background images for
song lyrics. A new feature introduced in Version 4.2 allows us to add backgrounds to a
song temporarily by simply dragging an image from the internal browser or Windows
Explorer.

In this example, we will:

Load a lyric (song) into the running sheet

Open Windows Explorer to a folder containing images

Add background images to individual slides of the song in the preview

See the results in the Output

1. With the preview open, load a song file and select it so it appears in the Preview
panel.

2. Launch Windows Explorer from the Start button - or press +E (Windows Key +

26
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E) and browse to a folder containing images

Selected s ong in  preview  w ith  W indows  Explorer

3. Now we drag an image onto the first slide. You'll notice that the text changes to
show the image in the background as confirmation that the request was successful.
This is a sample based on the actual output font settings, so it won't come as a
surprise that the text is likely to be too small to read. Notice that the image starts
from the first text slide and will always leave the very first slide blank for operational
reasons.
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Drag an  im age on  to the s ong

4. What if we want to read the text again? There is a new background button, labelled
[Bg] that we can turn on and off. Simply click this to restore to the original view. The
image is still attached to the song.

Show/h ide the background

5. Just for fun, let's add two more images to the 3rd and 4th verses. Since each
update populates the image to the end, we should always work from left to right.
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Drag m ore im ages  on  to the s ong

6. The result will look like this...

Preview  w ith  background im ages

7. Now let's see how this looks in the output. The overlay image controller appears at
the bottom of the thumbnail list, so that we can see and control the appearance of
the image. Note that this displays in its own presentation 'layer' and will override an
image if loaded in the regular background section. You have full control of the image
displays and can turn the song images off at any time, or indeed create interesting
effects with partial fading of two images!
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Song w ith  background im ages  in  the Outpu t area
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8. And a later slide...

Song w ith  background im ages  in  the Outpu t area
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That's it! Just a quick reminder that this feature is for temporarily assigning, or replacing,
background images linked to a specific song. Images attached here are not saved
permanently with the song file. (That feature may come in a future update.)  If you need a
permanent link you can edit the file itself and use the .b tab.

3.4 Displaying images

In this example, we will:

Add an image to the running sheet

Look at how images and display schemes are displayed in the browser

Load a folder of images to the running sheet

Send the image folder to the Output

1. In the browser, click Home  and navigate to the Backgrounds \ Images \
Eyedrops folder

Tip: Select Thumbnail view (small or large) to preview the images

2. Add a single background item to the running sheet by either:
Double-click item

Select item and press ENTER or F10

Select item and click the Add  toolbar button
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Drag item up into running sheet using the mouse

3. Navagate back up, then down to the Backgrounds \ Gradient folder
You'll notice these are not real image files, but something with a P4Ds extension.
Yet, they display an image in thumbnail view!

4. Instead of adding a single item to the running sheet, navigate back to the
Backgrounds \ Images level

5. Select (but don't drill into) Eyedrops

6. Press F10 or click the Add  toolbar button to add the image folder to the running
sheet.

7. Select the entry in the running sheet and send to Output.
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8. The lower Images tab will be populated with all of the images.

Folder of im ages  loaded in to the ou tpu t

Click the magnifying glasses or slide the bar to resize the
images.

9. Click the best fit  or stretch  buttons to suit your display requirements.

10. Click an image to load to the background.

11. Use the Background controls to display the image (with or without an overlay image)

3.5 Displaying PowerPoint

In this example, we will:

Load a PowerPoint file into the running sheet

Review its options in the Preview panel

Send it to the Output

See how Presenter can display the slides as static images
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Review the PowerPoint media controls

1. Check the icon in the bottom left-hand corner to verify that Powerpoint has been
detected.

2. Open the Preview panel (F4)

3. In the browser, click Home  and navigate to the Media \ PPT folder

4. Add Nasa0.ppt to the running sheet. It may take a few moments to process the file
and generate images.

5. Select the entry in the running sheet. The list of images will appear for preview.

PowerPoin t Preview

6. There are several options here that can be set. For full details, refer to Preview
Panel > PowerPoint

Let's pause for a moment and consider the ways in which we can work with PowerPoint...

There are three ways to present a PowerPoint presentation:-

120
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We can:

A) launch and control just the PowerPoint viewer
B) disable the viewer and display the slides as static background images in Presenter,

or
C) control both the viewer and static images at the same time

These three modes are controlled by the two buttons:   and   which
can be set in the preview panel or after the item has been loaded to the output.

Let's look take a closer look at each scenario...

A. Control external PowerPoint Viewer only

If your presentation has embedded animation, such as flying bullet points or slide
segments appearing with various transitions, you will need to allow the PowerPoint viewer
to display your presentation if you want these animations to be shown. Let's prepare that
now while the item is still in the preview panel.

A1.Select:

[PPT] - PowerPoint mode on (and leave [Image] off)

[Adv] - Auto advance mode + [5] (= seconds to advance)

[A.Play] - Auto play option, which starts the presentation when sent to the output

[FoH] - Select the PowerPoint Viewer output to display

A2. Now click Output   button (or press the space bar) to load to output. The
PowerPoint presentation should start automatically and advance through the slides in
5 second intervals.

Observe this view of the output area...
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Notice that the [Master] and other program buttons are off. This is because we are
deferring control to an external program (the PowerPoint Viewer). Now, you could in fact
be asking Presenter to 'multi-task' and display something else (eg. song lyrics or images)
on another output at the same time, but as far as PowerPoint is concerned, we do not
use the program buttons to control it.

Refer to Manual Controls  below for navigating a slideshow.

B. Control PowerPoint slides as static background images in Presenter

When a PPT item is loaded from the browser to the running sheet. A collection of images
are generated and stored in a temporary folder. These are used to provide the thumbnails,
but they can also be used for display, in much the same way as a folder of images are. If
your presentation has embedded animation or transitions, such as bullet points appearing
or elements of a slide appearing with each mouse click, you can still use this option, but
realize that the animations will not be shown. Presenter can only show the slide as a still
(static) image. To enable the animations, refer to A. Control external PowerPoint Viewer
only  above.

Select the PPT item in the running sheet if it is no longer showing in the Preview panel.

B1. Select:

[Image] - Image mode on (and leave [PPT] off)

[FoH] - Select the output to display. In this example, we have both [FoH] and
[FB].
Note: These are the smaller output buttons under the [Image] button, not the larger
ones on the right hand side.

B2. Now click Output   button (or press the space bar) to load to output. The
Output will enable the relevant slide program outputs ready for display.

B3.Ensure the Program Background is active and select the PPT thumbnail images as
required.  These will be loaded into the Output background in the same manner as the
regular images.

49
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Observe this view of the output area...
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With PPT off, we are simply treating the slides as images which are loaded to the
background, so all our slide program output controls apply. Since Presenter loads these
to the regular background area, we could in fact overlay lyrics if we wanted to.

Notice that in the above sample, we are previewing the foldback which has the green
numbers: 1 (-2) / 3. This is a new feature in Version 4.2 to allow the presenter on stage to
see where they are up to in terms of the slide numbers.

C. Control external PowerPoint viewer and as static background images in
Presenter at the same time

Now that we have seen how to activate the PowerPoint viewer and display the slides as
static images, we can combine these two features, provided we have at least two outputs
enabled. For example, you can have the live PowerPoint viewer displayed on the Front of
House and the (static) images displayed on the foldback.  If you have only one output, this
feature will not be relevant to you.

Achieving this is simply combining the steps in A. and B. above...

C1. Select:

[PPT] - PowerPoint mode on

[Image] - Image mode on

[Adv] - Auto advance mode + [5] (= seconds to advance)

[A.Play] - Auto play option, which starts the presentation when sent to the output

[FoH] - Select the PowerPoint Viewer output to display (button on the RHS)

[FoH] - Select the image output to display. In this example, we have both [FoH]
and [FB].
Note: These are the smaller output buttons under the [Image] button, not the larger
ones on the right hand side.
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C2.Now click Output   button (or press the space bar) to load to output. The
PowerPoint presentation should start automatically and advance through the slides in
5 second intervals. As each slide changes, the static image will load to the
background. Ensure the background fader is up and the relevant program buttons are
on.

Observe this view of the output area...
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Notice that since we are including the static image in the display for the foldback, we must
have the [Master] program on as well as the background slide output.

Note in particular that the static slides are shown on the
foldback only. It makes no sense to have the program FoH
active, since are have already directed the PowerPoint viewer
to display on this output.

Manual Controls

Whenever the PowerPoint slide show is active, you can navigate in a number of ways:

Click the larger Prev and Next buttons to step through bullet points/slides

(These are the same as the smaller buttons  and   in the media controller)

Move the slider to jump to a slide

Click directly on the thumbnail image to jump to a slide

Click the Black  and White  buttons for black/white slides

Use a remote presentation controller.
To make effective use of a controller, enable the remote controller option in Options
> General . This will monitor the F5 and ESC keys to start and stop the
presentation. If enabled, the keyboard symbol in the bottom left hand corner will
change to indicate a remote controller.

Preview to Output Settings

Let's take a moment to review how the PPT options in the preview panel correlate to the
output controls.

72
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PowerPoin t Properties

The settings that are used by the PowerPoint Viewer are loaded into the lower right hand
corner.
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Outpu t for PowerPoin t Viewer

The output used by the PowerPoint Viewer is a single selection from the RHS of the
preview, as is referenced by other media types.
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Outpu t for Im age Slides

The output assignments used for static image display are the smaller buttons directly
underneath the [Image] button in the Preview panel. These are mapped to the slide
buttons in the Program Control  area.

Recap and Extra Notes:

The [Master] button and other program buttons have no
effect on the PowerPoint slide viewer - only the static images
when enabled.

The PowerPoint viewer may flash momentarily on the primary
monitor as it starts up.

The Play and Stop actions only apply to starting and stopping
the external PowerPoint viewer

Stop the slide show if you want to change the output or
PowerPoint settings.

It is possible that the [Adv] option does not always advance
the slideshow on it's own. Switching focus to the slide show
application (PowerPoint Viewer) on the Windows task bar
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usually rectifies this.

If the slide show ends with the fine print "End of slide show,
click to exit.", you'll need to do just that: move the mouse
across the monitors and click directly on the output. To
prevent this slide from appearing, open MS PowerPoint
separately and select Tools > Options > View tab and
uncheck End with blank slide. There is also a reminder of this
being set in the Preview panel.

Only one PPT file can be active at a time. This means that
you will not be able to load another PPT file into the running
sheet while a slide show is active, since a brief load is
required to retrieve the images.

The PPT control area will appear squashed on a monitor with
a height of 768. (eg. 1024 X 768 screen). In this case close
the Output preview window which will extend the output area
upwards. See Control Window Details - Resizing Control
Sections

There is a setting in the PowerPoint application to force the
presentation window to different dimensions when a slide
show is activated. For example, force the output to 800X600 if
it is currently 1024X768. That is, PowerPoint changes the
system display properties on the fly. This is likely to cause
side effects when other media is displayed and should be
disabled (left at the default setting).

When using a remote presentation controller, remember that
it relies on the right application having focus in order to
receive the keystroke commands. In this case, either
Presenter or the PowerPoint Slide show application itself
should have focus (as can be verified from the Windows task
bar). When the slide show ends, the system may not return
focus to Presenter. Therefore a stop, followed by a run
request from the remote may not restart the presentation.

3.6 Playing a video clip and overlaying text

In this example, we will:

Load a video clip into the running sheet

Review the clip in the Preview panel

Send it to the Output

Load a lyric file and overlay the text on the video

100
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1. In the browser, click Home  and navigate to the Media \ Loops \ EyeDrops
folder

2. Open the Preview panel (F4)

3. Add the sample mpg EDHi616.mpg to the running sheet.

4. Select the entry in the running sheet.

5. (Optional) Set the begin Mark In  and Mark Out  end markers (not
normally done for looping clips!)

6. Loop on  of off  as required.

7. Select the required output for the video to appear on.

Note that the fader level defaults to 0 with [Auto Play] on . This means that the
video will fade in from black (at the assigned speed) when it starts. If you just want to cue

the video in the output and not have it start, then turn the [Auto Play] off .

Tip: If there is already a video clip playing, it will fade out before the next video is started if 
Auto Play is active.
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Video Preview

8. Click Output  button (or press the space bar) to load to output
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In the Output Video Section...

Video Outpu t Con troller

9. To control the video, use either:
a) the play/pause/stop/etc. buttons
b) the fader button (with the auto-play button active). This will toggle play/pause

modes.

10. A preview can be displayed in the top output section.

The preview may not appear for some video formats.

While this preview option is a convenient feature to use, it
does utilize extra CPU resources and is not recommended
for continuous operation.

To overlay text...

11. Open Options and check that Output Settings > Video have been set up.

12. Ensure the video clip is in loop mode or otherwise long enough to be continuously
playing while overlaying text

13. Select a lyric file and send to output.

14. In the Program section, select the same output for Slide as for Media.
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Sam ple Program  View
(Standard)

15. Navigate through the song pages as usual.

Notes:

Overlayed text will appear frozen if the video stops.
Ensure the loop option is active for continuous overlay
presentation.

If the text looks larger than expected, it will be a result of the
video dimensions being smaller than the output.

If the text looks larger than expected, it will be a result of the
video dimensions being smaller than the output.

3.7 Displaying a Flash file

In this example, we will:

Load a Flash file into the running sheet

Send it to the Output

1. In the browser, click Home  and navigate to the Media \ Flash folder

2. Add one of the sample flash files eg. Flash9.swf to the running sheet.

3. Select the entry in the running sheet.

4. Preview the item if desired. eg. To select the required output for the flash to appear
on.
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5. Click Output  button (or press the space bar) to load to output

In the Output Flash Section...

6. Use the media buttons to control the display.

7. Repeat the above, selecting a sample flash from the Media \ Loops \ Flash folder

8. Notice that this time the loop  option will be set by default if the any part of the
filename or path contains the text loop.

Notes:

Flash7.swf and Flash9.swf are different Adobe versions (v7 &
v9) of the same FLA source.
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3.8 Capture live feed

In this example, we will:

Initiate a capture request

Review the live capture in the Preview panel

Send it to the Output

Load a lyric file and overlay the text on the live capture feed

1. Open the Preview panel if closed (F4)

2. Select Capture from the drop-down Presets button

3. Select an input capture device from the Select Input button

4. Press the adjacent Play  button to activate the preview (optional).

5. Select the required output for the capture to appear on.

6. Click Output  button (or press the space bar) to activate on the output

To overlay text...

7. Open Options and ensure that Output Settings > Video have been set up. (Video
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and capture share the same output settings)

8. Select a lyric file and send to output.

9. In the Program section, select the same output for Slide as for Media.

10. Navigate through the song pages as usual.

Notes:

Overlayed text will appear frozen if the capture device
stops.

If the text looks larger than expected, it will be a result of the
capture device dimensions being smaller than the output.  For
example, on a webcam

Captured input through firewire or USB generally introduces a
delay. This can be anything from a 0.1 sec up to 0.5 secs

3.9 Playing a DVD

DVD Playback

DVD playback will almost certainly require the
installation of a codec pack with MPEG2 DirectShow
support. (See next topic: Media Formats: Media
Codecs )

Our own testing - along with feedback from a number
of users - has provided very reliable DVD playback in
some instances, while less reliable (eg. momentary
freezing of the display) in others.
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While we endeavor to improve DVD support for future
releases, we would recommend where possible to
import DVD content into one or more video clips
(copyright permitting) - particularly if you intend to only
show a small portion of the DVD. The clips can then be
loaded into the running sheet and have the volume,
start/end points and other properties preset for more
user friendly operation. Several free products such as
Handbrake* are available to achieve this. Alternatively, if
the DVD was authored in-house, then you would of
course have the option to simply create one or more
video clips instead from the original editing software.

* Handbrake (http://handbrake.fr) is one product that
imports DVD content. Selecting the normal preset
with H.264 video codec should work in most
instances.

In this example, we will:

Load and activate a DVD  directly to the Output

Load and preview a DVD  and select a title and chapter before sending to the
Output

A. Load and activate a DVD directly to the Output

1. Open the Preview panel if closed (F4)

2. Select DVD - Quick play from the drop-down Presets button

This action will attempt to:
Load the first available DVD

Identify the available titles and chapters

61
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Activate the first (eg. FoH) output window

Start the DVD at the title with the most chapters. This is (almost) always the main
feature.

3. The DVD controller will be shown in the output section. You can assume manual
control at this point.

The navigation buttons (arrows and middle 'Enter' key) along with the other DVD actions
(Title, Menu and Resume) are used for moving around a DVD menu in the same manner
as a regular DVD player.

Notes:

The auto-start feature to a nominated chapter may be
prohibited on commercial media that includes an obligatory
copyright notice at the start. Playback of this message
(typically 15-20 seconds) will be followed by the title menu, at
which point user control will then be available.

B. DVD Preview

1. To preview a DVD before output, select the second option DVD from the drop-down
Presets button
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2. Select the drive from the dropdown DVD menu.

3. Press the Play button.

4. Use the navigation controls (or the mouse cursor directly in the preview display) to
locate the starting chapter. You can also nominate the title-chapter directly from the 
Start: list if you know it. Leave the [A.Play] button on (green) to request that the DVD
starts after loading in the output.

5. Click  button (or press the space bar) to activate the DVD on the
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output.

Notes:

As noted above, the auto-start feature to a nominated chapter
may be prohibited on commercial media.

The transparency feature allows you to overlay text onto any
background (including DVDs). However, the operating system
may disable transparency (along with other Aero features) for
performance reasons during DVD playback.

Potential problems playing DVDs:

1. The audio plays but no video
2. An 'Active X' Window appears, even when playing in the preview panel
3. No video or audio at all, and a small yellow exclamation appears above the media

controls

The problem in all of these cases will most likely be related to the DirectShow codec
support in your system and/or display adaptor. See Media Formats  for more details.

4 Media Formats

Presenter supports the following media formats:

Type File extension Comments

Lyrics TXT See Lyric Editor  for
format details.

Images BMP, JPG, JPEG, GIF,
WMF, ICO, PNG

Audio WMA, MP3, MID, CDA,
WAV, MKA

Some formats depends on
additional codecs to be
installed.  See below.

Presenter Display Scheme P4Ds See Background Editor
for details

Adobe Flash SWF, DCR Requires Adobe Flash plug-
in

Microsoft® PowerPoint PPT, PPS, PPTX, PPSX Requires MS PowerPoint or
Office/2000 or above

Video AVI, FLV, MPEG, MPG, MP4,
MOV, VOB, WMV, MKV

Some formats depends on
additional codecs to be
installed.  See below.

Image Folders n/a These files are created
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internally when a folder of
images is added to the
running sheet

Capture n/a A capture item is initiated
from the Preview-Preset
option. Some formats
depends on additional
codecs to be installed.  See
below.

DVD n/a A DVD item is initiated from
the Preview-Preset option.
Most formats depend on
additional codec to be
installed.  See below.

Media Codecs

Presenter 4 uses Windows DirectShow technology for video playback, capture and
DVD processing. If you have trouble playing video or a DVD, numerous codecs are
available that support DirectShow and should solve most problems.

There are several codec packs hosted on sites such as www.free-codecs.com or
www.codecguide.com. We have found the K-lite Codec Pack (Full version)
includes support for many DirectShow formats.

Important: If you are trying out multiple packs, only
install one codec pack at a time. In other words,
uninstall one before installing another.

Video playback problems

A number of common video formats, such as WMV, AVI and MPEG1, should work in
Presenter without any problems.  Other formats, such as MPEG2 require:

DirectX 9c or above (which should be standard on all WinXP, Vista and Windows 7
systems)
Compatible video card (hardware)

Compatible codec

If any of these conditions are not met, you may experience problems such as:
Video refusing to load or start

No vision and/or sound

An un-expectant window appearing with a title of "Active X"

The video window reducing to about half it's size when the fader is less than 100%

In most cases, Presenter will at least trap the error and indicate the problem with a
small yellow exclamation icon in the corner of the media controls. If this appears in
the Preview panel, the output button will be disabled. You can try to rectify the

http://www.free-codecs.com
http://www.codecguide.com
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problem by clicking on the yellow icon. This will reload the media as a second
attempt.

Troubleshooting Video playback

Firstly, test the supplied video in the Presenter4\Media\Loops\EyeDrops folder.

See if the video will play on your primary monitor by creating a custom monitor
definition in a corner of your primary monitor (eg. top right, 50% width & height) and
assign this to the second (O2) output.
If you or an associate authored the video, try rendering it into another format

Try converting the file into another format

Try another codec pack

Try installing Presenter onto another computer

While we cannot guarantee that Presenter will support all
video formats, we will try to help if possible.  Feel free to
contact us with your query. This also (certainly) applies if
you are evaluating Presenter before purchase.

The above information also applies to DVD, live capture
and, to a lesser extent, audio playback.

5 Options

5.1 Monitor

It will come as no surprise that the most fundamental configuration decision has to do
with your monitor setup and where you want Presenter to display your media.

This section enables you to:

Identify the video adaptors (monitors) on your computer

Access the Windows Display Properties settings to configure the monitors

Define where the Presenter outputs will be displayed

These steps are best performed in sequence.

Hardware

This screen lists the monitors that Presenter can identify from the information the
Operating System tells it.  You can launch the Windows Display Properties program
to make changes if required.
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Mon itor hardware review

Custom Monitors

Monitors detected by Presenter are pre-configured to the full screen. However, if you
require an output to occupy a smaller area, or perhaps span multiple monitors, then
you can create what we call custom monitor definitions. Once created, custom
monitors can then be assigned to one or more outputs. If you only require a full
screen setting for each output, then there is no need to define these.

If you only have one secondary monitor to work with, but would like to work with and
view all three outputs, you could use this feature to create custom monitor regions,
each occupying 1/4 of the screen. Eg. Top-Left 50%, Top-Right 50% and Bottom-
Left 50%.
You would then assign each output to each of these definitions.

The layout diagram represents your desktop so you can use it as a guide for size
and placement. The selected output is highlighted.
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Cus tom  m on itor con figu ration

Output Definitions

This screen is where you assign, or patch the monitors to the program outputs that
you control.

On initial startup, the outputs will be auto-assigned to whatever monitors you have available,
starting from the 2nd one (leaving the first for the control window).

There are three outputs available, all of which can be used to send media and slides.
Note however that No. 1 has the added ability for slide transition effects and the
foldback has the clock, countdown and media timer feature.

The line that has input focus is highlighted for reference.
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Sam ple Outpu t defin itions

 

5.2 Output Settings

Output settings enable you to identify and configure the appearance of overlay text on
each type of output.

Output Setting Properties

Each output setting has:
A style for each of the three sections: header, body and footer

Margin settings for left, top, right and bottom

Height values for header and footer

Styles

Font and alignment attributes are defined in Styles. The concept of styles will be
familiar to users of word processors.  They also enable you to define a semi-
transparent background, similar to that seen beneath captions on television
broadcasts.  You can modify an existing style or make a copy to create a new one. 
Styles are shared across all outputs, so a change to a style in one section will have
immediate effect if it's used in another section. See Style Editor  for more details.91
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Header and Footer margins

The header and footer values are measured from the top and bottom margins (and
not from the edge of the output.  A zero value for either area will suppress the output
accordingly.

Output Preview

The lower section provides a preview of the output. Text appearance will be
representative provided the area is large enough. (Presenter's auto-font sizing will
chip in to resize the font down if not.)

Output Types

Output 1, 2 and Foldback

These are for static image overlay. The opacity settings provide enhanced effects,
particularly for headings and footers.

Sam ple ou tpu t defin ition

Margin settings provide boundaries for each of the sections. When a value has
focus, the corresponding area is highlighted in blue in the diagram on the right. This
provides an approximate guide and is not strictly to scale. Further margin settings
within each of the heading/body/footer boundaries are independently set within each
style.
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Video

Video has it's own settings, allowing the most suitable font to be chosen over a
moving background. When you activate text for overlay on video, the text appearance
will change from whatever current settings are in place (eg. Output 1) to these
settings.   This applies to all overlay text, except Messages.  For example, sending a
scripture text to an output with a video playing will use the Video settings, not the
scripture settings.

The reason for this is twofold:
You are likely to want to have greater definition for the text when overlaying video. 
This may mean using a larger font and/or a more pronounced outline.
The video dimensions will affect the size of the text, so this will enable you to make
appropriate adjustments compensate.

Please note:
The opacity settings are not supported for text overlaying
video, as the underlying Windows DirectX technology is
limited to using black as the key color. A different color
background will generate a solid effect, so when you
assign styles for video overlay, ensure the opacity setting
is 0%.

It will be helpful to understand that the system will render
the text using the actual video dimensions before it is
scaled to fit the output screen.  The effect of this will be
apparent if you overlay text on a small video (eg. 320 X
240).  The text will appear to fill the screen because
Presenter will auto-scale the font down (to avoid
cropping). Rescaling the combined image will then
enlarge the text, resulting in, all likelihood, an unintended
effect.

These settings apply to the Capture overlay as well.
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Message and Scripture

Message and Scripture settings apply to their respective text when sent as static
slides.

Sam ple ou tpu t defin ition  for dis playing Scriptu re

5.3 Control Window

This section enables you to adjust the appearance of the main control window.

General

General settings adjust the keyboard and program control view.

PPT Keyboard Emulation: Enabling this setting may be desirable if a presentation
remote control device is attached to the computer. To test that the remote is
working, click in the [Select to test] edit field and click the buttons on the remote.
Pressing the right arrow on the remote, for example, should register with the text: 
PgDn. The "Show Slideshow" button will typically alternate between F5 and ESC.

Control Window Monitor: Presenter will by default start up on the primary monitor
(as defined by Windows).  You can nominate an alternative monitor for the control
window to initially appear on.  Note that if the monitor is not detected during start up,
the control window will revert back to the primary monitor.
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Program View: This option controls whether the program view selection panel is
displayed. This panel provides selection between three views of the program control
area: Basic, Standard and Advanced. Switching between each view is useful to
become familiar with the various control features of Presenter. Once you settle on
your preferred view, turning off this selection to hide the panel may be desired to
avoid accidentally changing the control layout. See Program Control  for details on
each view.

Transparency Link: Overlaying text onto a background image is performed
internally within Presenter, as is overlaying text on to video. It is also possible to
overlay text on video using the transparency feature, which extends to overlaying
DVD, Flash or other content external to Presenter altogether. Under most
circumstances it is generally desirable to enable either Overlay + Background or
Overlay + Transparency, but not Overlay + Background + Transparency.
Enabling this option will, for each output independently, toggle transparency off if you
turn the background on, and conversely background off if you turn the transparency
on. Leave this option unchecked if you want to manually control the settings or have
reason to enable all three - which, by the way, may be used to create interesting
effects!
This option applies only to the advanced program view.

Control W indow  General Settings

Running Sheet

This specifies the appearance of the running sheet.  This will not normally require
alteration, except for multi-language users requiring song information to be displayed

146
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in a more suitable (Unicode) font for their language.

Runn ing Sheet Settings

Thumbnails

This page specifies the appearance of the overlay thumbnails. You can change the
font properties of the text and tag  numbers as well as the thumbnail sizes.

The thumbnail height can be adjusted directly from the control. Using the mouse, click and
'grab' the bar under the first (blank) slide and move up or down.  This will remain in effect
until it is changed again.
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Thum bnail Settings

Media

This page provides options for slide control and media volume.

Override Slide Selection: Overlay slides include a blank slide which is selected by
default when the item is sent to the output. You can override this to select the first
(non-blank) slide.  A slide specifically selected in the Preview panel will carry through
to the output, irrespective of this setting.

Auto fade speed: The fade buttons in the output control area provide a simple fade
on/off toggle operation for overlay text, background images. When pressed, the slider
speed is set to value between -5 (downwards) to +5 (upwards). You can adjust the
default speed here to suit your needs. The actual speed is influenced by the graphics
hardware, number and dimensions of each output.
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Auto video speed: This setting provides the default fade speed when videos are
started and stopped. You can override this value for each video in the preview or
output areas.

Media Volume: This value determines the initial volume for non-looping video, audio
and flash files when they are added to the running sheet. A media file is assumed to
be for looping purposes if the text "loop" is part of the file or pathname. In these
cases, the volume level is zero. Adjustment to all items can of course be made
either in the preview or output sections.

The volume level (along with other settings for each media item) is retained as part of the
item property when the running sheet is saved and reloaded. It remains in effect until
removed from the running sheet.

Media Settings

5.4 Display

Display settings alter the appearance of copyright information and the behaviour of
specified text.

Copyright

This section enables you to control how the title and copyright information is
presented.  Songs include this information if they include a ".i" tag line, or have been
downloaded using the CCLI SongSelect service (www.ccli.com).

http://www.ccli.com).
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Song Title: Options here include:

Where and when to include the title in the output:
o Hide
o Header - on the first slide only
o Header - on all slides
o Footer - on all slides

Case options:
o Same case (as presented in the lyric file)
o Proper case - Ensure the first character of each word is in upper case
o Upper case - Make the title upper case

Show copyright information: Options here allow you to

Display the copyright on the first page only

Enter your CCLI license number which may be included on the display.

Control how many lines to use for the copyright information (not including the
title)

Example footer: presents a visual guide to the options chosen. (The actual
appearance is determined by the selected footer style for each output).

The header and footer styles determine the appearance (font, alignment) of the song
information. If either are disabled, then no information is displayed, regardless of the
settings made here.

CCLI Song Select Options
Check for song artist on line 2: This option is provided for compatibility with an
earlier SongSelect format where the artist name was specified on the second line of
the text file. Select this option if you find that loaded lyric files include an extra slide at
the top with just the artist name.

Use licence no. from song file if found: If checked, a CCLI license no. found in the
footer block of the song file will override the default number entered above.

Changes made on this page will take effect next time a lyric file is added to the running
sheet.
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Sam ple Copyrigh t Settings

Text Override

This powerful feature provides the means of identifying specific text and overriding
the default font characteristics. In Presenter 3, this was referred to as Subheading
Settings.

Text overrides are configured by defining a set of rules to:
locate a character string in each line of (overlayed body) text, and

applying an action, such as overriding the font properties, or hiding the line
completely.

Typically, this can be used to highlight key words, such as Chorus, Verse, (Ladies
echo), etc. but equally applies to presenting Leader... Congregation... response
dialogue text.
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Sam ple Text Override Settings

Select Add or Edit to enter (or update) the override details. Select Delete to remove
unwanted entries.

Sam ple Text Override Details

5.5 Advanced

The Advanced settings are for administrators of Presenter and should rarely need
changing.

Browser Home

Browser Home specifies the root, or top level folder used by the integrated browser.
While it is possible to navigate files across your entire system, the Presenter home
location provides a convenient reference point for general use. In particular,
subfolders for Backgrounds, Lyrics, Media and Running Sheets are established for
added recognition.

Examples:
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Song files under the Lyrics folder can be previewed in detail and thumbnail view

The browser jumps to the lyrics folder when initiating a quick search

Presenter display scheme files (*.P4Ds) can be previewed in thumbnail view when
located under the Backgrounds folder 
Backgrounds embedded in lyric files (.b tag) do not need to be qualified with the
path if they exist in any Backgrounds subfolder
The item tasks recognizes these folders to provide context based actions for item
maintenance
Item names are saved in running sheet files with the path name relative to the
home location when ever possible. Items loaded from outside of this reference are
stored with the full path name.

Conversely, song and display scheme files navigated to within the browser but
external to the Browser Home can be selected for the running sheet but will not have
their special appearance applied.

Browser Hom e Settings

Spelling

Spelling Settings allow you to customise the spelling options and choice of
dictionaries. These settings apply to the song lyric editor.

Note: Additional language dictionaries are available for download from our web site.
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Spelling Settings

6 Editors

6.1 Lyric Editor

Lyric files are plain text documents that can be edited by any Windows editor such as
Notepad or MS Word (when saved as TXT). The built in lyric editor has an advantage in
that it recognized the lyric components (title, author, information, sequence & key) as well
as providing a spell checker.

Editor details

The editor is launched from the item task panel in the browser.
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Item  edit reques t

Select the Unicode check box when editing text for Asian languages (eg. Chinese).

A 'live' editor is available for ASCII text which will underline spelling errors. Right-click
the word for suggestions.

The live speller facility is not available for Unicode files.
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Lyric Editor

Lyric File Format

Title: The first line is taken as the title.

Body: The body text is grouped into one or more "pages".  Pages are separated by
one or more blank lines.  A period ('.') in column 1 on its own denotes a blank line
within the page.

Control Information: Control information may be specified by including a period ('.')
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in column 1 followed by a specific character.  These are:-

Tag Name Description Example

.i Song/
Lyric
informati
on

Usually copyright
notice and may
include the artist/
composer

.i ©2009 Great Music

.s Sequenc
e
informati
on

User defined
information to
assist the operator
in the order the
song is played.

.s V1 Ch V2 Ch Ch

.k Key
informati
on

The music key .k G
.k Eb

.0

.1 thru

.9

./

.*

Keyboar
d
shortcut

Tag displaying
keyboard shortcut
for jumping to the
slide (block of text
following the tag). 
This typically
corresponds to
verses, chorus,
bridge, reprise,
etc.

.1

./

.0

.b Backgro
und

Specifies an image
or display scheme
to use as the
background.  A
single .b tag at the
top of the file will
apply to the whole
song.  However,
multiple .b tags
can be included
throughout the
song to override to
another image. 
You could
effectively have an
image for every
page.
The filename does
not require the full
path if the image
file resides in (or
below) the
background folder.

.b Sunset.jpg

.b OurLogo.P4Ds
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.- Output
delimiter

Used to specify
alternative text for
the second output.
Can be used for
alternate language
(see sample
below) or any other
purpose.  If
omitted, the default
action is to
duplicate the slide
on each output.

Show this text on FoH
.-
Show this text on O2 at the same time

.# Comme
nt line

Used to add
annotations to
assist the
operator.
Accompanying text
is included in the
slide thumbnails
but not shown on
the output display.

Lyric text here
And here
.# 4 bar instrumental before
.# returning to chorus

All control information is optional as far as Presenter is
concerned. Copyright information should be included
when required.

Presenter will also recognize songs provided in CCLI
SongSelect format.
Tip: Song lyrics downloaded from SongSelect may be in UTF-8
format. This is normally OK except for the possible inclusion of
spurious characters. Opening and re-saving the txt files as ASCII
should fix this.

The sample Test1 file (included in Lyrics Sample folder of your installation) gives
running commentary of the tag lines.

Sample Lyric File - Test1

Test 1
Artist
.i Information with a ".i" tag
.s Sequence info with a ".s" tag
.k G

.b EyeDrops01.jpg
This slide has background tag:
".b EyeDrops01.jpg"
As the first background tag,
It will be the default for the song
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But can be overridden by another background tag.
.-
This text appears on Output 2
It is demonstrates the multi-output feature of Presenter 4.
The text file has the tag:
".-"

.b EyeDrops02.jpg
This 2nd slide has background tag:
".b EyeDrops02.jpg"
.-
.b EyeDrops03.jpg
Another split page.
This time with it's own background.

When any background tag is identified,
the "Overlay background" preview appears
at the base of the Overlay thumbnail view.

If enabled, this takes precedence over
the common background image view.

.b Green2.P4Ds
The background tag here is:
".b Green2.P4Ds"
Denoting a Presenter display scheme definition.
Note that none of these background files
Include the full path name.

An unqualified filename is located automatically
in the "Backgrounds" folder (or sub folder).
This allows for easier maintenance of the tag information.

Text Override Rule Examples
Next line starts with the word "Chorus"
Chorus - The Chorus line
This line contains "Miscellaneous"

Next line starts with "("
(Ladies echo)

Next line starts with "~"
~Leader text 1
Congregation text 1
~Leader text 2
Congregation text 2

This slide includes annotation comments
that only the operator can see.
The lines start with ".#"
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.# Comments for the operator

.# that accompany this slide

Sample Lyric File - Multi-Language

Shout to the Lord 
.i         

.b EyeDrops01.jpg

.1
My Jesus, my Savior
Lord there is none like you
.--
      ,      
           

All of my days I want to praise
The wonder of your mighty love
.--
               
                

My comfort, my shelter
Tower and refuge and strength
.--
      ,      
              

Let every breath, all that I am
Never cease to worship you
.--
        ,         
              

.0
Shout to the Lord
All the earth let us sing
.--
        ,             

Power and majesty
Praise to the King
.--
        
           

Mountains bow down 
And the seas will roar
.--
        ,           
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At the sound of your name
.--
          

I sing for joy at the works of your hand
Forever I love you forever I stand
.--
                    
                      

Nothing compares 
To the promise I have in you
.--
                        

Additional Spelling Dictionaries

A limited number of dictionaries are included in the
base system to contain the size of the download setup
file.  Please visit presentersoftware.com for many other
(free) dictionaries in various languages.

6.2 Background Editor

Background images loaded directly into Presenter are positioned on the output in a 'best
fit' scenario. This means they are centered as large as possible without cropping or
changing the aspect.

There may be times when you need to:
Display a solid color

Display two colors with a gradient effect

Display an image, but change some aspects such as stretching, tiling or positioning it in
a corner.

Background display schemes provide this functionality to save you the trouble of manually
editing image files.  These are simply text files with a .P4Ds extension containing the
configuration settings. Presenter's built in background editor is best used to create and
maintain these files.

Editor details

The editor is launched from the item task panel in the browser.

Type: Specifies whether a single color, gradient (two) color or image scheme is
required.
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The remaining settings are enabled based on the type.  Note that each color has an
opacity value, ranging from 0% (fully transparent) through to 100% (solid color).

The Bg Color setting for an Image represents the unused area if the image does not
cover the entire area.

Exam ple Single Color Background Schem e
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Exam ple Gradien t (Two Color) Background Schem e
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Exam ple Im age Background Schem e

6.3 Style Editor

Styles define a group of properties that determine how text is displayed. A style is
assigned to either the header, body or footer of each output setting.

Editor details

The Style editor window is launched from the Output Settings  option.

Description: Enter a name for the style of your choosing.
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Text: Font type, size, style and color are specified here.

Text Effect: You can specify a drop shadow or outline around the text.  Outline is
recommended when displaying text over a background, video or capture feed.  Depth
determines the thickness of the shadow/outline (in pixels).  Line spacing is used to
adjust the vertical space between the lines.

Internal Text Margin: Adjust these values to add additional padding on each of the
four sides.

Alignment: Click one of the nine options to specify the placement of the text.  Eg.
Bottom left hand corner.

Background: These settings provide a means to add a color layer behind the text.
You can achieve many effects using a gradient (two color) setting with differing
opacity levels and bias.  This would not normally be applied to a body style but would
add interest to, for example, a Scripture heading or Message footer.  See the sample
screen shots below.

The background settings defined here should not be
confused with the background image on the program
output. They apply to the style area only (header, body or
footer) and are layered behind the text, but in front of any
background that may be active.

Reiterating a note on the Output Settings: The opacity
settings apply only to text overlaying static images. An
opacity > 0% will be interpreted as 100% (solid color)
when overlaying video or a capture feed, so when you
assign styles for video overlay, ensure the opacity setting
is 0%.
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Style samples

Exam ple: Body text
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Exam ple: Mes sage footer
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Exam ple: Scriptu re heading
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Exam ple: E ffect of gradien t background bias  near 100  percen t

Exam ple: E ffect of gradien t background bias  near 0  percen t
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7 Control Window Details

All the action takes place on the control window!  This is where you:
Load and save running sheets

Browser for and select items to display

Fine tune the media settings in the running sheet, (eg. determine the output, check
video loop, mark in/out settings, etc.)
Load the item for display

Change overlay slides, start/stop media, show/hide outputs, change slide transitions,
etc.

The sub-sections are explained in greater detail in the topics that follow.

Startup Monitor

The control window will start up on the primary monitor
by default.  Refer to Options > Control Window  if
you need to specify a different monitor.

Control Appearance

Common button appearance

All buttons with two states (on/off, enabled/disabled) have a common appearance.

Off,
disabled

Red bar

Exam ple: Mas ter
program  off

On,
enabled

Green
arrow

Exam ple: Mas ter
program  on

Common media control appearance

With a few minor variations in appearance, all of the media items share a common
control panel.

Exam ple: Video m edia con trol

72
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Resizing Control Sections

The sub-sections within the control window have a divider, or splitter that may either
resize or perform an open/close action. Use the mouse to drag a moveable slider to
adjust the section size.  For example, you may wish to increase the browser area
while adding items to the running sheet. When the event starts you may prefer to
reduce this back down to give the running sheet more room, and at the same time
move the main left-right splitter to the left to give the overlay thumbnails more room.

The samples here illustrate each of the splitters.

Main  splitter next to the overlay
section  dividing left and righ t

hand s ides
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Browser left/righ t s plitter

Browser res ize splitter

Preview  open
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Preview  closed

Overlay background

Outpu t preview  open



101Control Window Details

©2011 Discovery Systems

Outpu t preview  closed

Control Window Screen shots

Main  Con trol W indow  w ith  the Preview  Closed and Bas ic
Program  View

Main  Con trol W indow  w ith  the Preview  Open  and
Advanced Program  View
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7.1 Top Menus

The top level menus provide access to just about every setting and function. Most of them
provide a secondary access to the other buttons and settings somewhere on the control
window.

Menu Shortcuts

Scanning through the options will also serve as a
reminder to the available shortcuts . For example, F4
opens and closes the Preview panel .

Sam ple m enu  show ing the Outpu t options

7.2 Status Bar

The status bar is located across the bottom edge of the control window.  It provides
feedback on certain aspects of the program.

Keyboard input: Provides feedback as to whether keyboard actions for item navigation
are enabled.  See Keyboard Shortcuts  for details.
MS PowerPoint status: Indicates whether Presenter found MS PowerPoint installed on
this computer. A red X through this image indicates it is not available.

16

116

16
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Adobe Flash status: Indicates whether Presenter found the Flash plug-in installed on
this computer. A red X through this image indicates it is not available.

Hint feedback: The text area that follows provides a brief indicator of what object the
cursor is positioned over - be that a menu option, button or other control.  Normally,
such hints are shown as small popup yellow balloons, and this is still the case for
several areas of the control window.  However, the balloon hint is deliberately disabled
for some controls, especially those on the right hand side.  The reason for this is to
prevent the hint from 'bleeding' across to the next monitor, which may be active on a
projector.

Status  bar h in t w ith  the cu rsor on  the Item  Add bu tton

7.3 Browser

The browser is a key component of the Control Window.  This is where you locate and
select items to be added to the Running Sheet.

You will immediately recognize the similarity between the browser and Windows File
Explorer, both in appearance and function. The desktop shows all drives and locations,
and the right mouse button context menu works when an item is selected.  The main
difference is that double-clicking an item does not open (or launch it's associated
application), but rather performs the item add operation (if a known file type).

Drag and Drop

The browser supports drag and drop to and from the
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desktop or other File Explorer window.

Sam ple Browser w ith  Folder View

Browser Toolbar

Row 1

Back Return to previous folder

Forward Move to next folder (in history)

Up Move up one folder

Desktop Go to the desktop

Home Go to Presenter's home folder
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View Change file view: Icon, List, Small Icon,
Details, Thumbnail-Small, Thumbnail-
Large

Tasks Task menus for selected item (eg. New/
Copy/Edit Lyrics, New folder)

Add Add item (or folder of images) to the
running sheet

Explorer Open Windows Explorer at the current
location. See below .

Row 2

Location Shows the full path of the current location

Lyric search Lyrics quick search facility

Row 3

Lyrics checklist Display the check list view for lyrics

Image checklist Display the check list view for images

Media checklist Display the check list view for media
(video, PPT, etc.)

Search Display search panel

Folder Display folder (tree) view

Adding Items to the Running Sheet

Items are added to the running sheet by clicking the green plus  icon in the
toolbar or just pressing ENTER or F10 when they are selected. Files are processed
according to their extension. The add request will be ignored if:

The file has an extension that is not supported

A selected folder contains no recognizable images

Loop Mode

Media items are loaded with default properties, such as
a volume level of 70% and loop mode off. However, to
assist with the common scenario of utilizing video clips
designed to be background loops for overlayed text, 
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Presenter will scan the full file name (and path) for
the literal text 'loop'. If this is found, loop mode will
be switched on and volume set to 0. For this reason
the default installation includes a 'loop' directory with
sample media under this location.

Search facility

There are two ways to search for files.

A. Quick Search

The search edit box in the browser toolbar provides a means to quickly search lyric
files.

1. Press F3 to jump to the quick search entry (or click in the field)
2. Enter search text and press ENTER
3. The browser will relocate to the lyrics folder and search both the filename and the

TXT contents

Lyrics  qu ick s earch

B. Full Search

This feature is for general file searching.

1. Navigate to the top level folder that you want to start the search from
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2. Press Ctrl-F to display the Search side panel (or click the magnifying glass, 4th
button from the right)

3. Enter (part) filename and or contents and click the Search button
4. When finished, press Ctrl-F (or the button) again to return to the last panel

Search  panel

Editing items

The Lyric Editor  and Background Editor  can be launched from either:

A) The browser:

The task bar button 

The Item Task panel

B) Running Sheet
Right-click on the item to bring up the context menu

C) Preview Panel
The [Edit] button on the right hand side of the preview panel

Example: Browser Item Task Panel
1. Navigate to the folder containing the item
2. Ensure check list, search and folder view modes are off. The item task panel

should be visible on the left hand side.
3. Open the Item Task command group
4. Select the item to be edited or duplicated and click the task menu

81 88
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The edit options are only enabled for lyric files located
beneath the lyrics folder, and for display scheme files
located beneath the background folder.

Item  task reques t

Copying files

You can use the regular File Explorer shortcut 
Ctrl+Mouse Drag followed by a rename F2 to create a
new file.

Folder Check List

The folder check list view will be familiar to users of previous versions of Presenter.
Instead of listing the folders in the standard tree view, a check list of folders
(including sub-folders) is generated enabling multiple folders to be selected. As each
selection is made (checked or unchecked), the list of files on the right hand side is
refreshed (with a 1 second delay).

Hold the CTRL key while clicking a checkbox will select/
deselect all sub-folders as well.

Filter list checkbox: When checked, only the selected folders will be displayed.
Uncheck to list all files (ignoring the individual folder selections).
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Export list...: Opens the export list dialog in order to generate a CSV list of
(the selected) song lyrics. You can use this as a basis for
creating a spreadsheet of song titles (and related information).
This option only applies to the lyrics checklist view.

Export lyric lis t as  CSV

Refresh button: Press to refresh the right hand side. Since the list is
automatically updated after a selection is changed (one second delay), this option is
not normally required. Use it if you make file changes outside of Presenter.

The checklist feature is available for song lyrics, backgrounds and media.

Lyrics checklist view
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Background checklist view

Media checklist view

Launch Windows Explorer

The Launch Explorer button opens the Windows file explorer at the current location
in case you ever need to work with files outside of Presenter. 
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Launch  W indows  Explorer

7.4 Running Sheet

The running sheet is used the queue items in the order you require for your event. (In
Presenter Version 3, this was called the Play List.)

Sam ple Runn ing Sheet

Columns

Image: An iconic representation of the item. For video, the first frame is
grabbed (if possible)

1, 2, FB: Identifies whether the item is activated for this output. You can click on
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individual  entries to turn the corresponding output on or off - or
click on the header to toggle the output for all items. Note however
that for media items, only one output can be active at a time.

Reference: The filename (minus the extension)
Title: Item title where possible.  For example, the title property of MP3 files

is extracted for display here
Info: Additional information where possible, such as a video's dimensions
Length: Uses as a counter for some items (lyric slides) or time for media

items. This will include a start-end range for video, or starting slide for
lyrics in [brackets] if applicable.

Video item  w ith  s tart/end poin ts  dis played in  the length  colum n

Running Sheet Actions

You can save and reload running sheets for future use or simply to keep an historical
record. The main running sheet menu looks like this:
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Runn ing Sheet Menu

Running Sheet actions:

Open (Ctrl-O) - Open an existing Presenter running sheet (.P4Rs extension)

Save (Ctrl-S) - Save the current running sheet

Save As.. (F12) - Make a copy of the running sheet under a new name

Edit the running sheet properties (see below)

Actions on an item once it is loaded:

Re-order (Ctrl-Up Arrow) or (Ctrl-Down Arrow)

Remove (Ctrl-Del) or just (Del) if the running sheet has focus

Open the Preview panel  (F4) to view a selected item

Save/Save As.. the running sheet (Ctrl-S or F12)

Drag and Drop

The running sheet supports drag and drop. You can
drag a file from either the browser, desktop or other File
Explorer window.  You can also drag items up and
down the list to reorder them.

Selecting an item in the running sheet triggers one of two actions
depending on the Preview panel state:

Preview panel 
open

The item is loaded into the preview area only.  This has no effect
on the output.

Preview panel 
closed

The item is loaded directly to the output, initiating display if the
relevant program settings are enabled.

116
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 The behaviour of a closed panel will be more familiar to
Presenter Version 3 users.

Item Actions

A context menu (right-click) provides options to edit, remove or open the containing
folder in the Windows explorer.

Runn ing Sheet con text m enu

Running Sheet Properties

You can assign additional information to running sheets for future reference.

1. Open the properties window by clicking on the small [Edit] button in the top right
hand corner.

2. Enter the details as required.
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Title: Brief description
Date: Date of the event
Session: Free format text. Initially the drop-down list will be empty, but as you

enter text that will appear next time.  Examples: AM, PM, 9am,
Midweek, etc.  In other words, use this field to help identify the event

Description: Additional notes as required

Export: This option will export the item name and other details to a CSV file so
that you can keep track of your media usage. If the specified CSV file
already exists, new data will be appended to the end.

Open: Click this button to open the CSV file. The default associated
application will be used, which is likely to be Excel if you have MS
Office installed.

The running sheet properties are completely optional.
You can utilize them as much or as little as you wish.
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7.5 Preview Panel

The Preview panel provides a convenient means to view details of a selected running
sheet item. This allows you to:
a) confirm you have the right item loaded, and
b) adjust any run time related settings, such as looping a video clip, setting start/stop

points, etc.

You can show or hide the Preview panel to suit your needs. It would be typical practice to
have the Preview panel open while preparing items in the running sheet and closing it
during the event.

Preview Mode

By way of reminder, when the Preview panel is open, a
selected item in the running sheet is loaded only as far
as the preview.  When closed, the item is sent directly
to the output.

Preview panel details

Sam ple Preview  of Lyrics

The Preview panel area consists of a description area, common functions, plus
custom settings that vary according to the type of media.

Launches the
editor. This
applies only to
lyrics and
display
schemes.
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If enabled, the
next item is
auto-loaded
into the
Preview panel
after the
current item is
sent to the
output.

Use this to
send the
current item to
the output. If
the Advance
button is
active, the next
item is loaded
into the
preview. In that
scenario,
repeatedly
pressing the
output button
will
progressively
load each item
in turn.

This drop-
down list
includes media
types that don't
fit into the
context of a
regular item.
Currently this
includes DVDs
and capture
devices. Use
the drop-down
list to open
these panels
where you can
select the
device, preview
the program
and send to the
output as
required.



118 Presenter 4

©2011 Discovery Systems

Use these to
preset which
output(s)
should be
enabled when
the item is sent
to the output.
This only has
meaning if you
use more than
one output.
Example: A
song may be
sung by the
choir requiring
the words to be
sent only to the
foldback.
Presetting this
during the
preparation
time avoids
accidentally
showing the
words on the
front screen.

The caption
of these
buttons is
controlled
by Options >
Output
Definitions

.

Item Preview Settings

Changes to the item in the preview (and/or actual
output) are saved in the running sheet.  When you open
the running sheet at a later date, these values are
restored.
Example: A media item will have the mark in and out
points reset when first added to a running sheet,
indicating the entire item will be played. If these settings
are adjusted either in the preview or output media
control area, they are preserved for next time.

68
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Media Preview Panels

Screen shot examples of the preview panels are shown below. A common media
control panel (containing the play, pause, stop, etc. actions) is adopted in most
cases. This is accompanied by additional controls as noted. See the Quick Start
Tutorials  for further discussion on the item control options.

Audio files

Auto Play: Select this option to start the audio track when it is sent to the output.

Audio Preview

Flash files

Auto Play: Select this option to start the flash file when it is sent to the output.

Flash  Preview

Image Folder

22
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Im age Folder Preview

PowerPoint

PPT: Select this option to indicate that you want the Microsoft PowerPoint Viewer to
control the presentation.

Image: Select this option if you want to treat the PPT slides as static images to be
loaded into the background. Enable the required outputs as required (buttons
underneath)

Adv: Select this option and time (seconds) to set the auto advance (timing) setting of
the slide show. This is normally used for unassisted presentations.

A.Play: Select this option to start the PowerPoint when it is output.

PowerPoin t Preview

Video files

Enable Preview: This selection determines whether the preview option is made
available in the output. Normally this is left enabled. However, when enabled an extra
DirectShow component is incorporated into the video stream which has been known
to have side effects to certain types of video (such as alter the aspect). If you have a
situation where a video appears fine in the preview thumbnail, but incorrectly (for any
reason) when sent to output, then disabling this option may help.

Auto Play: Select this option to start the video track when it is sent to the output.
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Video Fader: Specifies the initial video (brightness) level. When completely down
(level = 0), and the Auto Play option is set, the auto fade in feature will be activated
when the video is sent to the output.  For all other levels, the nominated setting will
be carried through and remain in effect. Live adjustment to the video level can be
made in the output control panel.

Video Preview
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7.6 Output Control

The right hand side of the Control Window is dedicated to managing the output.

Outpu t Con troller
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Each area of the output is described in the topics that follow.

7.6.1 Preview

The output preview provides feedback on the output appearance of text overlay, static
images and, if the video/capture preview is active, the currently playing video/capture.

Preview Details

The preview tabs appear for each enabled output. The first tab will typically be
selected most of the time when controlling song words, as this represents the output
1 view. The tab labels are user defined according to the Output Definition  options.

If you have multiple outputs enabled, click on a tab or press F9 to rotate through
them.

The image is derived from the actual output to provide
accurate proportions. This reduction in size will mean
that the image, and in particular, the overlay text will be
reduced in quality.

The previews represent the slide view and video
clips only - not other media formats (Flash, PPT, DVD).
To preview video, enable the [Preview] button in the
video control area when it is active.

Outpu t 2  Preview

68
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Foldback

A second available output is typically designated as a foldback feed.  This output has
extra features to display a clock, count up and down timers and remaining time of a
video or audio clip or Powerpoint show.

Foldback Preview

Each of these features are enabled from these buttons.  Press the [...] settings
button to display the respective options.
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Foldback clock s ettings
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Foldback coun t up s ettings
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Foldback coun tdown settings
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Foldback m edia s ettings

7.6.2 Overlay Control

The overlay area provides three tabs to control song lyrics , messages  and
Scripture .  These are discussed in the following topics.

129 136

142
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7.6.2.1 Lyrics

This overlay area is used to control the song lyrics. You can use the keyboard shortcuts
 (if enabled) or the mouse to activate a slide.

You can use the context menu (right-click) to make adjustments to the number of
columns, height and whether a fade transition to or from the first (blank) page is enabled.

16
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Overlay Lyric Thum nbnails
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Overlay thum nbnail heigh t adjus tm ent

Live Sequence Update

The sequence line is an aid to operators if songs are sung with a predetermined
arrangement. You can now edit the sequence field of the song lyrics while the song
is loaded to the output. This can assist the operator during rehearsal when the
arrangement is often worked out. A quick change to the sequence line here avoids
opening the lyric editor, making the change, saving the file and reloading the song.

1. Click the small sequence edit button next to the sequence line.
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Editing the Sequence line

2. Make the required changes and click the green tick. (Click the red cross to
cancel.)
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Editing the Sequence line

Sequence updates here are saved permanently to the
original file.

Operator Comments

The sequence prompt facility illustrated above is now complemented with inline
annotations within the lyric file itself. These comments are shown within each lyric
page thumbnail, but are not output to the screen. A new .# (hash) tag is used to
define them.

1. Here we can see the comment lines inserted into the lyric TXT file.
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Operator com m ents  in  a s ong file

2. The comments are shown in the thumbnail slides for the operator, but not sent to
the screen.
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Operator com m ents  shown in  the s lide
thum bnails
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Overlay Background Image

If a lyric file has one or more background images defined, the bottom panel opens. 
This indicates that this song has one or more pre-defined images. The image will
update as required as pages are selected. This panel appears (and hides)
automatically, depending on whether a loaded song has background images defined.
It can be manually opened and closed with a click of the horizontal bar. The
orientation of the images and controls adjusts to the available width.

Providing this level of control allows you to determine whether any pre-defined
images with a lyric file should be used at the time of presentation.

The padlock symbol indicates if the fade control should operate in sync with the
overlay text fade control.

Enabling this image will take precedence over the regular
background image (under the program controls). You
could  potentially generate interesting effects with partial
fade settings of either one.

7.6.2.2 Message

The message area is used to edit and display ad hoc messages. Click the Message tab
in the Output Overlay area, or press F7 (which rotates through the overlay views).

Initially, the first entry will be displayed. This is reserved as a blank slide.
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Preparing a m essage

The [Edit] button toggles between Edit and Preview mode.
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Creating a message

1. In Edit mode, select a button (1-20) to enter text in the header, body and/or footer
sections.

Preparing a m essage

2. Optionally, change to preview mode to view the results.
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Preview  the m essage

3. Select the required Output destination. Eg. FoH

Select the ou tpu t for the m essage

4. Click [Output] to show the message. The fader will activate to 100% (top).
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Click [Outpu t}  to show  the m essage

5. While the message output is active, you can:

change to another (prepared) message slide (or the first blank one)

adjust the fade slider to give the message a semi-transparent appearance

switch back to the song lyrics overlay and continue navigating song slides as
required while the message remains active

6. Click [Output] again to fade out the message.

Notes:

When in Standard or Advanced Program view, ensure
the Program Master Output is active.

Messages will have their own appearance according to
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the options defined. This allows you to define, for
example, a large font for the footer 'bottom third' text
along with an appropriate background style.

Tip: Click the blue Message Settings link to fast track
into the Options

The above steps are used to send messages on their
own or overlay background slides and/or song lyrics. To
overlay other media types (flash, DVD, video, etc.) or
even external applications on the desktop, you can use
the transparency feature found in the Advanced Program
view panel.

Example Message Output

Overlay m essage
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Message ou tpu t

Maintaining Message Slides

Right-click in the message thumbnail area to show the context menu options.
Here you can:

Change the number of columns

Adjust the height to one of several preset values

Clear the currently selected message (and move the following messages up)

Clear all messages from this point on

Overlay m essage

7.6.2.3 Scripture

The Scripture area is used to lookup and display Bible Scriptures on demand.

Entering a Scripture reference

1. In Edit mode, select the translation, book, chapter and starting verse you want to
display. You can also limit the number of slides to show. For most translations,
this will equal the number of verses. (One verse per slide.)



143Control Window Details

©2011 Discovery Systems

Entering a Scriptu re reference

Quick Reference Entry

Logic has been built in for quick verse selection using
the keyboard.

Once you start typing the book name and the desired
selection is shown, you can immediately start entering
the chapter number and input will jump to the chapter
edit box. Once you have typed the chapter, pressing
the space bar or delimiter key (.  ,  ;  :) will change input
to the verse field.

Example key strokes (with focus initially in the Book
selection):

Joh3.16

(ie. 7 characters) will select John, Chapter 3, Verse 16

This means that the Tab key or mouse click is not
required to move to the next field.

In addition, the up and down arrows within each of the
numeric fields will increase or decrease that value
accordingly.

2. Change to preview mode to view the results (optional).



144 Presenter 4

©2011 Discovery Systems

Scriptu re Preview

3. Click [Output] to show the reference.

Scriptu re Outpu t
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Sam ple Scriptu re dis play

As with Messages, Scriptures will have their own appearance according to the
options defined.

The footer section is currently ignored for Scripture.

Scriptures will also overlay video and capture as per lyric
slides, but the displayed text will be based on the video
settings, not the Scripture settings.

If the Scripture is not sent to the output when the [Output]
button is active, check that the Heading and Body styles
for Scripture in the Options > Output Settings have been
assigned.

Tip: Click the blue Scripture Settings link to fast track
into the Options
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Additional Translations

Only a couple of public translations are included in the
base system in consideration of the size of the
download setup file. Please visit www.
presentersoftware.com for many other free translations
as well as translations available for purchase.

7.6.3 Program Control

The panel in the middle of the right hand side of the output control area contains the main
program control options. This is where output windows are activated or hidden, and
provides various levels of control over the slider processing.

There is one exception to program control: Starting and
controlling a PowerPoint slideshow (via the external viewer
application) is performed from within its own control panel, not
via any of the controls here (including the Master selection).
Refer to the Displaying PowerPoint  tutorial for details.

Presenter provides a powerful level of control of overlay and background slides, and
media selection for up to three outputs. To cater for varying needs, there are three
program views available: Basic , Standard  and Advanced .

Start up Option

When Presenter starts for the first time, the basic view
is chosen if only one (additional) output is detected. If
two or more outputs are found, the standard view is
selected. Changing the program view will be
remembered from then on.

Switching between program views is possible at any time via the selection options just
above the control area. However, some care should be exercised since some settings
are disabled and take on default values in the process.

You can hide the selection panel to prevent unintended swapping of views via the Options

39
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> Control Window > General  settings.

7.6.3.1 Basic View

The basic view is ideal for simple program control. You would typically use this if you:

Only had one output (Front of House) configured

Do not need to display overlay text with a transparent background (to overlay non-video
media)
Do not need to use transition effects other than fading

Basic View Components

Thumbnail Section
Overlay: A thumbnail view of the currently loaded song lyric or scripture

slide plus activation button
Background: A thumbnail view of the currently loaded image slide plus activation

button

Program Section
Slide button: Activates the viewer window to show the active slide (background

and/or overlay)
Fader: Fades in or out the current slide. Manual fading is possible by

dragging with the mouse. Indicators shown for F6 and F8 shortcut
keys.

Fader button: (located below fader) Auto fades on/off
Slide Transition: Determines the speed of the auto-fade action. Move down for

slower speed, up for faster speed. At the max (top) position the
slides will 'cut' with no transition.

Media button: Activates the viewer window to show the currently selected media,
such as Video, Flash, Capture feed or DVD. If video (or capture) is
playing and the Slide button is also active, text on the overlay slide
will be mixed with the video image. For all other media, the media
viewer will override the slide image if active.

72
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7.6.3.2 Standard View

The standard view is used if you:

Have two or three outputs configured

Need a greater level of control over fading the overlay and background slides individually

Need to use transition effects other than fading

Do not need to display overlay text with a transparent background (to overlay non-video
media)
Do not need to control overlay and background slides independently to each output

Standard View Components

Thumbnail Section
Overlay: A thumbnail view of the currently loaded song lyric or scripture

slide plus fade controls
Background: A thumbnail view of the currently loaded image slide plus fade

controls

The auto fade button activates the fader up or down. The speed of this can be adjusted by
the Options > Control Window > Media  setting.

Program Section
Master Button: Enables (shows) all active slide/media windows (except

75
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PowerPoint Slide Viewer)
Slide Buttons: Activates the slide viewer for each output. Multiple outputs can be

active at any one time
Media Buttons: Activates the viewer for the selected media item, such as Video,

Flash, Capture feed or DVD. One output can be active at any one
time. If video (or capture) is playing and the corresponding Slide
button is also active, text on the overlay slide will be mixed with the
video image. For all other media, the media viewer will override the
slide image if active.

Transition: Displays the currently active transition for overlay and background
slides. Press to select:

Cut

Fade

The last 3 transition selections

Either one of two preset speeds

Open Transition settings dialog for selecting other transitions and speed

Transition effects apply to Output 1 (Front of House) only.

See also Slide Transitions .

7.6.3.3 Advanced View

The advanced view is used if you:

Have two or three outputs configured

Need maximum level of control over fading the overlay and background slides
individually
Need to use transition effects other than fading

152
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Need a separate transition when changing either overlay or background slides

Need to display overlay text with a transparent background (to overlay non-video media)

Require independent output control of overlay and background slides. (eg. to leave the
background blank for foldback irrespective of the background setting for front of house)

Advanced View Components

Thumbnail Section
Overlay: A thumbnail view of the currently loaded song lyric or scripture

slide plus fade controls
Background: A thumbnail view of the currently loaded image slide plus fade

controls

The auto fade button activates the fader up or down. The speed of this can be adjusted by
the Options > Control Window > Media  setting.

Program Section
Master Button: Enables (shows) all active slide/media windows (except

PowerPoint Slide Viewer)
Four control buttons for each of three outputs:
Overlay Button: Activates the overlay slide for each output. Multiple outputs can

be active at any one time.

75
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Background Button: Activates the background slide for each output. Multiple outputs
can be active at any one time.

Media Button: Activates the viewer for the selected media item, such as Video,
Flash, Capture feed or DVD. One media output can be active at
any one time. If video  (or capture) is playing and the
corresponding Overlay button is also active, text on the overlay
slide will be mixed with the video image. For all other media, the
media viewer will override the slide/background image if active.

Transition Section
Two transitions are available.
Overlay Button: This transition is initiated when an overlay slide is changed.

The button displays the currently active transition. Press to
select:

Cut

Fade

The last 3 transition selections

Either one of two preset speeds

Open Transition settings dialog for selecting other transitions and speed

Image Button: This transition is initiated when a background slide is changed.
The button displays the currently active transition. Press to
select:

Please note that the two transitions are not applied (or mixed)
at the same time on a change of slide. They simply allow you
to specify a different transition when presenting background
slides as opposed to moving between song lyric pages. It
may be that you just want to have a slower fade speed for
images and a quicker (but not cut) transition for songs. In this
case both transitions will be almost identical, except for the
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speed.

Transition effects apply to Output 1 (Front of House) only.

See also Slide Transitions .

Transp[arent] Button: Setting this button on the respective output sets the viewer
window to have a transparent background. This is useful for:

Overlaying text on Flash, DVD or other presentation - even external to Presenter

Overlaying messages on backgrounds other than slides

While transparency is active, the overlay fader will adjust the "alpha" level of the text,
giving a semi-transparent effect when not at 100%.

Be aware that the transparent effect imposes considerable
system resources and may cause other media to stutter
(particularly when changing slides).
This feature relies on the operating system display settings
having transparency enabled. For example, using a basic
theme in Windows 7 will disable the transparency feature.

7.6.4 Slide Transitions

The first (typically front of house) can have a transition effect applied to overlay slides
when displayed over images. Use the drop-down menu button to select either: cut, fade,
one of the last three custom transitions selected, as well as a preset speed.

Open the effect window with the Settings... option. You can select and preview the many
transition options as well as fine tune the speed.

152
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Trans ition  effect s ettings

To change one of the two preset speeds, adjust the dial and Shift-Click a speed setting to
assign the new value. A higher value represents a faster transition speed.
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